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1  INTRODUCTION 
The EIT Employer Self-Service (ESS) website has been designed to work with all modern browsers 

including Google Chrome, Mozilla Firefox, Microsoft Internet Explorer and Microsoft Edge.  We 

recommend that you keep your browser up to date with the auto-update feature included in most 

browsers.  While we cannot guarantee compatibility with all future browser versions, the Java platform 

on which the site is built allows for the most flexibility across different browsers.  Our preferred browser 

for performance and the fewest issues is currently Google Chrome. 

When using the User’s Guide please keep in mind that some of the screen shots might be slightly 

different and minor changes to the steps may not be reflected in this version of the guide. We will be 

constantly updating the user guide as the new information is available and/or changes are made. The 

updated User’s Guide will be posted on our web site as soon as possible. Please visit our website on 

regular basis to check if a new version is available. The updated version numbers will be posted and 

titled accordingly. 

 

2  FIRST TIME LOG-IN PROCEDURE 
Your Username is the seven-digit account number that will be provided by EIT when you are setup as an 

employer in the benefit administration system (usually starts with 000 or 00).  If you have not logged in 

before, your temporary password when your account is first setup will be your FEIN number, including 

the dash, plus the letters “EIT” (i.e. 34-9984321EIT). You will be prompted to change the password once 

logged in. Your new password will need to be between 8 and 20 characters long and include at least one 

letter, one number and one special character such as “-“ or “@”. 

The login screen will appear as below.  Please keep in mind that there are only five attempts allowed to 

enter the correct password. Your on-line account will be disabled after the fifth attempt of entering the 

incorrect password. Please contact EIT to enable your account if this happens. 
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After logging in and going through the password reset procedure the first web page you will see is the 

Home page below. Please contact Dan Sheffield at dsheffield@fundoffice.org or 312-782-5442 x275 if 

you have trouble logging in for the first time. Please make sure to include your seven digit EIT account 

number if you are contacting us via e-mail or leaving us a voice message.  

 

On the Home screen, you will be prompted with an important message regarding the use of the 

browser’s back button and a site usage agreement.  Once you have read this message, you may close 

the box by clicking on the “X” in the upper right corner. 

 

3  USER PROFILE 
Once logged in on the site, you can access your User Profile by clicking on your username in the upper 

right corner of the screen as in the picture below.   
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The following User Profile window will open.  On this screen, you have the ability to Change Password, 

Change Security Questions, View Login History and Change Accessibility (not currently used). 

 

 

3.1  CHANGE PASSWORD 

From the User Profile screen click on the Change Password button to open the ESS Change Password 

window.  On this screen you will enter in your Current Password, which you used to login, and a New 

Password.  When creating a new password, the password must comply with the complexity rules that 

are listed on the screen.  The security rules in the system have changed from what was acceptable in the 

past and may change in the future so always be sure to read what is on the screen. 

As you are entering the new password, the three bars to the right will show the strength of the new 

password to help you pick a password that is secure.  Once you are happy with the strength of the new 

password, you can enter it in the Confirm New Password box.  If you wish to continue with the password 

change, click on the Change button and confirm or click on the Cancel button. 
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3.2  CHANGE SECURITY QUESTIONS 

From the User Profile screen click on the Change Security Questions button to open the ESS Change 

Security Questions window.  On this screen you will be able to select 3 security questions that will be 

used to verify your identity when utilizing the Forgot Password link on the login screen.  Once you have 

selected the Security Questions and entered answers, you may click on the Change button to save or the 

Cancel button to discard the changes. 

 

 

3.3 VIEW LOGIN HISTORY 

From the User Profile screen click on the View Login History button to open the window below which 

will show the history for logins to your account.   Click Close when finished. 
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4  CONTACT OPTIONS 
On the right side of the screen, you will see a blue widget titled Chat or Call.  By clicking on this widget, 

it will expand to show several methods of contacting EIT. 

 

The contact methods include Email, Phone, Secure Message and Chat as shown below. 

 

When support staff are not currently available online, you will have the option to Send Us a Secure 

Message.  Clicking on this link will open the secure message window where you can select a topic and 

enter a message.  This messaging is contained within the software and can be used to transmit personal 

information such as social security numbers.  Type your message and click Send. 
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When support staff are available online, the messaging option will change to Chat live with a 

representative.  Click on the link to initiate a Chat session with the EIT support staff. 

 

Select a Topic for the help session. 

 

Enter your question. 

 

Wait for the next available support representative to accept the Chat session. 
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To chat with the representative, simply enter your comments in the text box and click the Send button.  

The chat session is secure so you may enter private information such as social security numbers. 

 

When your chat session is complete, you can Print the session or just click on the End Chat button 
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5  HOME TAB 
The Home tab was designed to provide you the majority of everything you need in one spot.  From this 

tab, you will be able to complete your work reports as well as access help and important news. 

 

 

5.1  OPEN WORK REPORTS 

The section of the Home tab labeled Open Work Reports has been setup to show you only the work 

reports which are at either Initial or Prebill status.  These are the work reports which you will need to 

process for the month. 

The work reports are generated for all employers on the first day of the month with an activity date for 

the prior month for regular payroll reports and the next month for PPlan reports.  The work reports will 

be generated either at Initial or Prebill status based on whether you fill out the reports online or print 

them out and manually fill in the report to send with your payment. 

While at the Initial status, the employer may make changes to the report.  When a report has advanced 

to Prebill, only staff at EIT may make changes. 

Once a report has been processed by EIT and payment applied, the status will move to Released and the 

report will no longer show up in the Open Work Reports screen.  At this point, no changes may be made 

to the report and any updates to hours or wages must be processed by EIT staff through the creation of 

adjustment reports.  
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5.1.1  EDITING A WORK REPORT 
The employer may modify only work reports that are at the Report Status of Initial.  To edit a specific 

report, click on the Actions menu next to the report you wish to work on and select Edit as in the screen 

below. 

 

When the report opens for data entry, the first thing you will need to do is enter a Date Received either 

by keying it in or selecting a date using the dropdown calendar.  The Date Received should be the date 

that you are completing the report. 
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Once the Date Received has been entered on the Summary tab, you can click on the Detail tab to begin 

the entry of hours and wages for each employee.  For employees that are already on the roster, click on 

the Hours field and enter in the number of hours that the employee has worked in the pay period.  Next, 

you will enter in the Capped wages for the employee. 

As you are entering data, it is best to click on the Apply button as you go along.  The Apply button will 

save what you have entered while keeping you in the active report. 

 

5.1.2  ADDING EMPLOYEES TO A WORK REPORT 
To add an employee to the report, you must first select the Job Category of the employee and then click 

on the Add Member button.  This will add a new line at the top of the grid.  To search for the employee, 

you can either enter the SSN or a Name in the Name field.  It is recommended that you utilize SSN to be 

sure you are reporting for the correct employee. 
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When entering a name, if more than one member is found, a selection box will appear and you can 

select the employee by clicking on their name. 
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If the employee you are trying to add to the report does not exist, you will need to contact either Sharon 

(x280) or Meg (x220) in the Contribution Accounting department to add them to the benefit 

administration system.  In the future, you will be able to add these employees yourself through the 

Roster functionality. 

5.1.3  DELETING EMPLOYEES FROM A WORK REPORT 
You currently have two options for removing employees from a work report.  If you wish to remove the 

employee from the current month report, but wish to have them remain on the roster, you will click on 

the checkbox next to the Actions link for the employee(s) and then click on the Delete Selected button. 

 

Your second option will be to terminate the employee, which will permanently remove them from the 

roster.  To do this, click on the dropdown menu in the Work Status box and change the employee from 

Active to Terminated.  Enter zero for both hours and wages.  Once this has been done, the employee 

will be removed from the next month’s reports. 
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5.1.4  NO MEN (ZERO HOURS) WORK REPORT 
If you have no hours and wages to report for an agreement, you will still need to submit the No Men 

report.  Edit the report as you normally would by entering a Date Received on the Summary tab and on 

the Detail tab enter zero for hours and wages.  Once saved, this report must be submitted along with all 

of the others. 

5.1.5  PRINTING A SUMMARY REPORT 
Once all hours and wages have been entered on the report, you are now ready to print the Summary 

Report for review prior to submission.  While still on the Detail tab of the report, click on the Tools link, 

select Reports from the menu and click on Summary Report. 

 

Depending on the browser you are using, the next screen will vary but will open a PDF file for the Work 

Report Summary.  This PDF can be printed or saved.  Once you have reviewed the report to confirm the 

hours and wages for each job category, you should click on the save button to return to the list of 

reports. 

 

 



E I T  E m p l o y e r  S e l f - S e r v i c e  U s e r ’ s  G u i d e  

P a g e  | 16 

5.1.6  SUBMITTING YOUR WORK REPORTS 
Once all of your reports, including the no men, have been reviewed and completed you are now ready 

to Submit.  While in the Open Work Reports section, click on the Action link next to the report you wish 

to submit.  From the dropdown menu, click on Submit. 

 

Once submitted, a Success message will appear with a note about submission.  Click on OK and the 

Report Status will change from Initial to Prebill. 
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5.1.7  PRINTING A WORK REPORT FOR MANUAL SUBMISSION 
If you have chosen to print out your work reports and complete manually, all of your reports for the 

month will generate at the Prebill status.  To print the blank report, click on the report to select and 

then click on the Tools menu.  Select the Reports option and the Employer Payroll Report. 

 

Depending on the browser you are using, the next screen will vary but will open a PDF file for the 

Employer Work Report.  This PDF can be printed and saved.  Once you have filled out the blank work 

report you will mail it along with your check to EIT.  If you have filled out your work report online and 

submitted, you will need to send nothing but the check. 

5.1.8  SENDING PAYMENT 
EIT currently does not offer an on-line payment option through our web site. If you wish to setup ACH 

for your payments, please contact the Accounting Group at EIT.  If you are sending payment via check 

please send to the following addresses based on type of delivery. 

Via First Class Mail:  

Electrical Insurance Trustees 

75 Remittance Drive - Suite 1615 

Chicago, IL 60675 - 1615 

 

Via Courier: (i.e.-Federal Express, UPS, or Messenger) 

Electrical Insurance Trustees 

Lockbox Number: 91615 

5505 N. Cumberland Ave., Ste 307 

Chicago, IL 60656-1471 

If you have completed your reports online, you do not need to send anything other than the check.  If 

you have filled out your report manually, send the entire report and the check. 
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5.2  NEWS AND ALERTS 

This section of the Home tab will show you important information such as changes to due dates etc.  For 

more detailed information about an item, click on the title. 

 

5.3  LINKS 

This section of the Home tab contains useful links to resources on the internet.  Additional content will 

be added to this page as it becomes available. 

 

5.4  FREQUENTLY ASKED QUESTIONS 

Content for the FAQ section is currently being developed.  Please check back soon for these online 

question/answer documents. 
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6  TRANSACTIONS TAB 
The Transactions tab is used to view all transactions associated with your account.  This includes work 

reports, work report adjustments, liquidated damages, debit/credit memos etc. 

6.1  TRANSACTIONS 

The primary section on this screen is Transactions.  The top portion of the section allows you to filter the 

transactions.  First, select a Contract if you have more than one billing entity setup.  Next, you should 

select the type of transactions that you wish to view from the Trans Type dropdown menu. 

 

Your next selection will be the transaction Status. 
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The final selection Report Status only applies to the work report transaction types.  Select from the 

dropdown menu.  After each selection, the list of transactions will automatically filter based on the 

selected items. 

 

Once you have filtered to find the transactions that you want, you can click on the Actions link next to 

an item.  The action choices vary by transaction type.  You may edit work reports from this screen using 

the same method as was described in Open Work Reports section of this document. 

6.2  UPLOAD FILE 

To the left of the transaction filtering dropdown menus, you will see a dropdown menu button labeled 

Upload File.  Click on this button select Mapped Work Report or Work Report Import.  The two types of 

report imports are described below. 

6.2.1  WORK REPORT IMPORT (LEGACY NO LONGER USED) 
The standard work report import format has not changed from the current specification which is 

documented in Appendix 10.1.  To upload the standard format report, click on the Upload File menu 

and select Work Report Import. 
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The Upload Work Report Wizard will open and allow you select the file to upload as well as give it a 

description.  Click the Browse button to find the text file that has been created using the standard 

specifications in Appendix 10.1.  Enter the Import Description and click the next button to proceed. 

 

The Processing screen will open and confirm that the file has been submitted for processing.  From this 

screen click on the Details button. 

 

The Details screen will show all information for the report file that you have uploaded.  Please review 

the information carefully before proceeding.  You may edit the information on a line by clicking in the 

field you wish to change and updating the value.  You may also Delete a line by clicking the Action link 

on the line and selecting Delete.  Once the file is satisfactory, you will click on the Process button. 
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After the report has processed, you will be able to see any errors that have occurred.  If the header or a 

detail line has produced an error, it will show in the Import Detail Status column.  If a line has errored, 

click on the Actions link and select Show Errors to be taken to the Import Errors and Exceptions screen. 

 

If errors or exceptions have occurred during the processing of the report, they will show in the screen 

below. 
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You may also create a formatted import report by clicking on the Tools link and selecting Standard 

Import Report as below. 

 

The report will open as a PDF file and will show the detail as below. 
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6.2.2  MAPPED WORK REPORT 
Instructions/Functionality for the Mapped Work Report import are currently being developed.  Please 

check back soon. 

 

6.3  FILE HISTORY 

Clicking on the File History button will open a screen where you are able to review files which have been 

uploaded.  If you chose to not process a given file, it will show on this screen and can be voided by 

clicking on the Action link and selecting Void. 

 

 

7  EMPLOYER INFORMATION TAB 
Documentation To Be Completed Soon 

7.1  BILLING ENTITY INFORMATION 

TBD 

7.2  EMPLOYER INFORMATION 

TBD 

7.3  EMPLOYER CONTACTS 

TBD 

 

8  ROSTER TAB 
The Roster functionality is currently being developed by our vendor and will be added to the site once 

complete.  Please check back soon for this enhancement. 
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9  DOCUMENTS TAB 
Documentation To Be Completed Soon 

9.1  FOLDERS 

TBD 

9.2  DOCUMENTS 

TBD 

  



E I T  E m p l o y e r  S e l f - S e r v i c e  U s e r ’ s  G u i d e  

P a g e  | 26 

10  APPENDICES 
 


